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Getting Started with VMware Workstation describes how to install and upgrade VMware® Workstation, create a typical virtual machine, and perform common virtual machine operations.
Intended Audience
This information is intended for anyone who wants to install Workstation and create a typical virtual machine. See Using VMware Workstation for complete information about Workstation, including how to use advanced Workstation features.
Where to Find Additional Information
See the following documents for additional information about using Workstation. All of the documents are available from the VMware Web site.
The Workstation online help contains quick reference information about Workstation settings and common tasks. It is available from the Workstation Help menu and when you click Help on a Workstation dialog box.
Host computers that run Workstation must meet specific hardware and software requirements. Virtual machines that run in Workstation support specific devices and provide certain features.
The physical computer on which you install Workstation is called the host system and its operating system is called the host operating system. To run Workstation, the host system and the host operating system must meet specific hardware and software requirements.
You must install Workstation on a host system that meets certain processor requirements.
Supported Processors
The host system must have a 64-bit x86 CPU that meets the following requirements.
Multiprocessor systems are supported.
When you install Workstation, the installer performs checks to make sure the host system has a supported processor. You cannot install Workstation if the host system does not meet the processor requirements.
Processor Requirements for 64-Bit Guest Operating Systems
The operating system that runs inside a virtual machine is called the guest operating system. To run 64-bit guest operating systems, the host system must have one of the following processors.
If you have an Intel CPU that has VT-x support, you must verify that VT-x support is enabled in the host system BIOS. The BIOS settings that must be enabled for VT-x support vary depending on the system vendor. See the VMware knowledge base article at http://kb.vmware.com/kb/1003944 for information about how to determine if VT-x support is enabled.
When you install a 64-bit operating system, Workstation performs checks to make sure the host system has a supported processor. You cannot install a 64-bit operating system if the host system does not meet the processor requirements.
Processor Requirements for Windows 7 Aero Graphics
To support Windows 7 Aero graphics, the host system should have either an Intel Dual Core 2.2GHz or later CPU or an AMD Athlon 4200+ or later CPU.
You can install Workstation on Windows and Linux host operating systems.
To see a list of the supported host operating systems, search the online VMware Compatibility Guide on the VMware Web site.
The host system must have enough memory to run the host operating system, the guest operating systems that run inside the virtual machines on the host system, and the applications that run in the host and guest operating systems.
The minimum memory required on the host system is 1GB. 2GB and above is recommended.
To support Windows 7 Aero graphics in a virtual machine, at least 3GB of host system memory is required. 1GB of memory is allocated to the guest operating system and 256MB is allocated to graphics memory.
See your guest operating system and application documentation for more information on memory requirements.
The host system must have a 16-bit or 32-bit display adapter. Use the latest graphics driver recommended for the host system.
To support Windows 7 Aero graphics, the host system should have either an NVIDIA GeForce 8800GT or later or an ATI Radeon HD 2600 or later graphics processor.
3D benchmarks, such as 3DMark '06, might not render correctly or at all when running Windows Vista or Windows 7 virtual machines on some graphics hardware.
Host systems must meet certain disk drive requirements. Guest operating systems can reside on physical disk partitions or in virtual disk files.
Disk Drive Requirements for Host Systems
Drive Type | Requirements |
---|---|
Hard disk |
|
Optical CD-ROM and DVD |
|
Floppy | Virtual machines can connect to disk drives on the host computer. Floppy disk image files are also supported. |
You can use any Ethernet controller that the host operating system supports.
Non-Ethernet networks are supported by using built-in network address translation (NAT) or by using a combination of host-only networking and routing software on the host operating system.
To use ALSA in a virtual machine, the host system must meet certain requirements.
You must have a supported Web browser installed on the host system to use the Workstation Help system
The following Web browser versions are supported.
Because Chrome does not support JavaScript on local systems, you cannot display the Workstation Help system in Chrome.
Workstation virtual machines support specific devices and provide certain features.
A guest operating system can be Windows, Linux, and other commonly used operating systems.
To see a list of the supported guest operating systems, search the online VMware Compatibility Guide on the VMware Web site.
See the VMware Guest Operating System Installation Guide for information on installing the most common guest operating systems.
Virtual machines support certain processor features.
Workstation considers multiprocessor hosts that have two or more physical CPUs, single-processor hosts that have a multicore CPU, and single-processor hosts that have hyperthreading enabled, to have two logical processors.
Virtual machines support certain virtual machine chip set and BIOS features.
The total amount of memory that you can assign to all virtual machines running on a single host system is limited only by the amount of RAM on the host.
On 64-bit hosts, the maximum amount of memory for each virtual machine is 64GB. On 32-bit hosts, the maximum amount of memory for each virtual machine is 8GB. Workstation prevents powering on virtual machines that are configured to use more than 8GB of memory on 32-bit hosts. Memory management limitations on 32-bit operating systems cause virtual machine memory to overcommit, which severely affects system performance.
Virtual machines support certain graphics features and keyboards.
Virtual machines support certain IDE drives and features.
Virtual machines support certain SCSI devices and features.
Virtual machines can have floppy drives.
Virtual machines support serial (COM) and parallel (LPT) ports.
Virtual machines can have USB ports and can support certain USB devices.
Virtual machines support certain types of mice and drawing tablets.
Virtual machines support certain types of Ethernet cards.
Virtual machines support certain Ethernet switches and networking protocols.
Workstation provides a sound device that is compatible with the Sound Blaster AudioPCI and Intel High-Definition Audio Specification. The Workstation sound device is enabled by default.
Workstation supports sound in Windows 95, Windows 98, Windows Me, Windows NT, Windows XP, Windows Vista, Windows 7, Windows Server 2003, Windows Server 2008, and Linux guest operating systems.
Sound support includes pulse code modulation (PCM) output and input. You can play .wav files, MP3 audio, and Real Media audio. MIDI output from Windows guest operating systems is supported by the Windows software synthesizer. MIDI input is not supported, and no MIDI support is available for Linux guest operating systems.
Windows XP, Windows Vista, Windows 7 and most recent Linux distributions detect the sound device and install appropriate drivers for it.
Windows 95, Windows 98, Windows 98SE, and Windows NT 4.0 do not have drivers for the Sound Blaster AudioPCI adapter. To use sound in these guest operating systems, you must download the driver from the Creative Labs Web site and install it in the guest operating systems. Creative Labs has Web sites that serve different regions of the world. The adapter name varies, depending on the region, but usually includes PCI 128.
For Workstation 7.x and earlier virtual machines, the vmaudio driver in VMware Tools is installed in 64-bit Windows XP, Windows 2003, Windows Vista, Windows 2008, and Windows 7 guest operating systems and in 32-bit Windows 2003, Windows Vista, Windows 2008, and Windows 7 guest operating systems.
For Workstation 8.x and later virtual machines, the High-Definition Audio (HD Audio) device is presented by default for both 64-bit and 32-bit Windows Vista and Windows 7 guest operating systems and their server counterparts. Windows provides a driver for HD Audio that is not part of VMware Tools.
On Linux host systems, Workstation 7.x and later supports Advanced Linux Sound Architecture (ALSA). Earlier versions of Workstation use the Open Sound System (OSS) interface for sound playback and recording in virtual machines running on Linux host systems. Unlike OSS, ALSA does not require exclusive access to the sound device. The host system and multiple virtual machines can play sound at the same time.
You can install Workstation on a Linux or Windows host system. Installing or upgrading Workstation typically involves running a standard GUI wizard.
If you have the packaged distribution of Workstation, the installation software is on the installation media in the package and the license key is on the registration card. If you have the electronic distribution, the installation software is in the file that you downloaded and the license key is sent to you in email.
The installation files for both host platforms are included in the packaged distribution. You can use the license key on both the Windows and Linux versions of Workstation. You need one license for each host system.
If you do not enter the Workstation license key during installation, you can specify the license key later, in Workstation, select Help > Enter License Key and enter the license key on the Workstation Activation dialog box. You can also purchase a license key and view the status of an evaluation license from the Workstation Activation dialog box.
See the VMware Web site for information on obtaining an evaluation license.
If you have an invalid license, Workstation prompts you to enter a license key each time you attempt to power on a virtual machine.
The only VMware products that can share a host system with Workstation are VMware vSphere Client and VMware vCenter Converter Standalone. You cannot install Workstation on a host system that has any other VMware virtualization products installed.
If the host system has another VMware virtualization product installed, you must uninstall that product before you install Workstation.
Before you upgrade the operating system on a Microsoft Windows host, VMware recommends that you uninstall VMware Workstation.
The way Workstation is installed and configured depends partly on the version of Windows used. As a best practice, to ensure that Workstation is properly configured for a new operating system, you must remove the Workstation application before you perform the operating system upgrade. Uninstalling Workstation guarantees that legacy components that apply only to older versions of Windows are not left behind .
For example, if you do not uninstall Workstation before upgrading the Windows operating system, some virtual network adapters might not function properly after the operating system upgrade. Before you uninstall Workstation, open the virtual network editor and note the settings used. You must configure these settings again after you reinstall Workstation.
When you uninstall Workstation, you need only uninstall the VMware Workstation application, not the virtual machines that you have created. When the operating system upgrade is complete, reinstall Workstation or, if you are also upgrading Workstation, install the new version of Workstation.
If you plan to use the Integrated Virtual Debugger for Visual Studio or Eclipse, you should install it on the host system before you install Workstation.
If you must install the Integrated Virtual Debugger for Visual Studio or Eclipse after you install Workstation, run the Workstation installer again and select Modify/Change to install the associated Workstation plug-ins.
See the Integrated Virtual Debugger for Eclipse Developer’s Guide and the Integrated Virtual Debugger for Visual Studio Developer’s Guide for host system requirements and supported operating systems. Both guides are available on the VMware Web site.
You can install Workstation on a Windows host system by running the installation wizard or by using the unattended installation feature of the Microsoft Windows Installer (MSI). The MSI unattended installation feature is useful if you are installing Workstation on several Windows hosts and do not want to respond to wizard prompts. You install Workstation on a Linux host system by running the Workstation bundle installer.
You run the Windows setup program and installation wizard to install Workstation on a Windows host system.
Remote connections and virtual machine sharing are enabled by default when you install Workstation. With remote connections, you can connect to remote hosts and run remote virtual machines. With virtual machine sharing, you can create virtual machines that other instances of Workstation can access remotely.
Shared virtual machines are stored in the shared virtual machines directory, where VMware Workstation Server (the VMware Workstation Server service) manages them. Remote users connect to VMware Workstation Server through HTTPS port 443 on the host system.
To change the shared virtual machines directory or select a different port during the installation process, you must select the Custom option. You can also change the shared virtual machines directory, select a different port, and disable remote connections and virtual machine sharing after Workstation is installed by modifying the Shared VMs Workstation preference setting. See Using VMware Workstation for more information.
Prerequisites
Procedure
If you log in to a domain, the domain account must also be a local administrator.
If autorun is enabled, the installation program begins.
Option | Description |
---|---|
If you are installing the software from a CD | The setup file is called setup.exe. |
If you downloaded the software | The setup filename is similar to VMware-workstation-xxxx-xxxx.exe, where xxxx-xxxx is the version and build numbers. |
Option | Description |
---|---|
Typical | Installs typical Workstation features. If the Integrated Virtual Debugger for Visual Studio or Eclipse is present on the host system, the associated Workstation plug-ins are installed. |
Custom | Lets you select which Workstation features to install and specify where to install them. Select this option if you need to change the shared virtual machines directory, modify the VMware Workstation Server port, or install the enhanced virtual keyboard driver. The enhanced virtual keyboard driver provides better handling of international keyboards and keyboards that have extra keys. |
Depending on your configuration, you might need to restart the host system to finish the installation.
After Workstation is installed, the VMware Workstation Server service starts on the host system. The VMware Workstation Server service starts whenever you restart the host system.
You can use the unattended installation feature of the Microsoft Windows Installer (MSI) to install Workstation on several Windows host systems without having to respond to wizard prompts. This feature is convenient in a large enterprise.
Prerequisites
Procedure
If you log in to the domain, the domain account must also be a local administrator.
If you are installing Workstation from a CD, the setup file is called setup.exe. If you downloaded the installation software, the setup filename is similar to VMware-workstation-xxxx-xxxx.exe where xxxx-xxxx is the version and build number.
For example: setup.exe /s /e install_temp_path
For example:
You can use the optional INSTALLDIR property to specify a file path for the installation that is different from the default location. The double quotes around the file path are important. All the MSI arguments are passed with the /v option. The outer quotes group the MSI arguments and the double quotes put a quote in that argument. You can use the optional REMOVE property to skip the installation of certain features.
When you perform an unattended installation of Workstation, you can skip the installation of certain features by specifying the REMOVE property in the installation command.
To specify a REMOVE property value in the installation command, use the format REMOVE=value. To skip multiple features, separate each value with a comma, for example, REMOVE=value,value.
REMOVE Property Values
Value | Skipped Feature |
---|---|
Authd | The VMware authorization service, which is used to perform tasks when you are not running Workstation as an Administrator user. |
Network | Networking components, including the virtual bridge and the host adapters for host-only networking and NAT networking. Do not remove this component if you want to use NAT or DHCP. |
DHCP | The virtual DHCP server. |
NAT | The virtual NAT device. |
When you perform an unattended installation of Workstation, you can customize the installation by specifying installation properties in the installation command.
To specify an installation property in the installation command, use the format property="value". A value of 1 means true and a value of 0 means false.
Installation Properties
Property | Description | Default Value |
---|---|---|
DESKTOP_SHORTCUT | Adds a shortcut on the desktop when Workstation is installed. | 1 |
REMOVE_LICENSE | Removes all stored licenses when Workstation is uninstalled. | 0 |
SERIALNUMBER | Lets you enter the license key when Workstation is installed. Enter the license key with hyphens, for example, xxxxx-xxxxx-xxxxx-xxxxx-xxxxx. |
|
HOSTD_HTTPS_PORT | Specifies the HTTPS port for VMware Workstation Server. | 443 |
REMOVE_ACCOUNT_INFO | Removes account information when Workstation is uninstalled. | 1 |
REMOVE_SETTINGFILES | Removes settings files when Workstation is uninstalled. | 1 |
STARTMENU_SHORTCUT | Adds a Start menu item when Workstation is installed. | 1 |
QUICKLAUNCH_SHORTCUT | Adds a quick launch shortcut when Workstation is installed. | 1 |
You run the Linux bundle installer to install Workstation on a Linux host system. On most Linux distributions, the Linux bundle installer launches a GUI wizard. On some Linux distributions, including Red Hat Enterprise Linux 5.1, the bundle installer launches a command-line wizard instead of a GUI wizard. You can run the installer with the --console option to install Workstation in a terminal window.
Remote connections and virtual machine sharing are enabled by default when you install Workstation. With remote connections, you can connect to remote hosts and run remote virtual machines. With virtual machine sharing, you can create virtual machines that other instances of Workstation can access remotely.
Shared virtual machines are stored in the shared virtual machines directory, where VMware Workstation Server (vmware-workstation-server) manages them. Remote users connect to VMware Workstation Server through HTTPS port 443 on the host system.
To change the shared virtual machines directory or select a different port during the installation process, you must specify the --custom option. You can also change the shared virtual machines directory, select a different port, and disable remote connections and virtual machine sharing after Workstation is installed by modifying the Shared VMs Workstation preference setting. See Using VMware Workstation for more information.
Prerequisites
Procedure
For example: su root
The command that you use depends on your Linux distribution and configuration.
Option | Description |
---|---|
If you are installing the software from a CD | The installer file is in the Linux directory. |
If you downloaded the software | The installer file is in the download directory. |
For example: sh VMware-Workstation-xxxx-xxxx.architecture.bundle [--option]
xxxx-xxxx is the version and build numbers, architecture is i386 or x86_64, and option is a command line option.
If you are using the --console option or installing Workstation on a host system that does not support the GUI wizard, press Enter to scroll through and read the license agreement or type q to skip to the [yes/no] prompt.
After Workstation is installed, vmware-workstation-server starts on the host system. vmware-workstation-server starts whenever you restart the host system.
You can use command line installation options to install Workstation on a Linux host system.
To use the installation options, you must be logged in as root. Exit from the root account after the installation is finished.
Linux Command Line Installation Options
Option | Description |
---|---|
--gtk | Opens the GUI-based VMware installer, which is the default option. |
--console | Enables you to use the terminal for installation. |
--custom | Use this option to customize the following installation settings.
|
--regular | Shows installation questions that have not been answered before or are required. This is the default option. |
--required | Shows the license agreement only and then proceeds to install Workstation. |
--ignore-errors or -I | Allows the installation to continue even if there is an error in one of the installer scripts. Because the section that has an error does not complete, the component might not be properly configured |
You can upgrade from Workstation 4, 5.x, 6.x, or 7.x to the current version of Workstation by running the Workstation installation program.
When you upgrade Workstation, the installation program removes the previous version of Workstation before it installs the new version.
To use the latest features, virtual machines that were created in the previous versions of Workstation must be upgraded to the current version of Workstation.
You must perform certain steps before you upgrade Workstation.
Procedure
Direct upgrades from Workstation 2 and 3 virtual machines are not supported.
You must recreate these mappings after you upgrade Workstation.
The files that you back up should include .vmdk or .dsk files, .vmx or .cfg files, and .nvram files. Depending on the upgrade path, you might not be able to run virtual machines under both the current version of Workstation and the previous version of Workstation.
During an upgrade from Windows XP to Windows Vista or Windows 7, the location of virtual machines might change. The Windows Vista and Windows 7 upgrade use the registry to map the virtual machines to a new location. Before the upgrade, the default virtual machine location on Windows XP is C:\Documents and Settings\username\My Documents\My Virtual Machines. After the upgrade, the default virtual machine location on Windows Vista and Windows 7 is C:\Users\username\Documents\Virtual Machines\guestOSname.
You can upgrade from Workstation version 4, 5.x, 6.x, or 7.x to the current version of Workstation on a Windows host system by running the Workstation setup program and installation wizard for Windows.
Remote connections and virtual machine sharing are enabled by default when you upgrade Workstation. With remote connections, you can connect to remote hosts and run remote virtual machines. With virtual machine sharing, you can create virtual machines that other instances of Workstation can access remotely.
Shared virtual machines are stored in the shared virtual machines directory, where VMware Workstation Server (the VMware Workstation Server service) manages them. Remote users connect to VMware Workstation Server through HTTPS port 443 on the host system.
To change the shared virtual machines directory or select a different port during the upgrade process, you must select the Custom option. You can also change the shared virtual machines directory, select a different port, and disable remote connections and virtual machine sharing after Workstation is upgraded by modifying the Shared VMs Workstation preference setting. See Using VMware Workstation for more information.
Prerequisites
Procedure
If you log in to a domain, the domain account must also be a local administrator.
If autorun is enabled, the installation program begins.
Option | Description |
---|---|
If you are installing the software from a CD | The setup file is called setup.exe. |
If you downloaded the software | The setup filename is similar to VMware-workstation-xxxx-xxxx.exe, where xxxx-xxxx is the version and build numbers. |
If you log in to a domain, the domain account must also be a local administrator.
Option | Description |
---|---|
Typical | Installs typical Workstation features. If the Integrated Virtual Debugger for Visual Studio or Eclipse is present on the host system, the associated Workstation plug-ins are installed. |
Custom | Lets you select which Workstation features to install and specify where to install them. Select this option if you need to change the shared virtual machines directory, modify the VMware Workstation Server port, or install the enhanced virtual keyboard driver. The enhanced virtual keyboard driver provides better handling of international keyboards and keyboards that have extra keys. |
Depending on your configuration, you might need to restart the host system to finish the installation.
After Workstation is upgraded and you restart the host system, the VMware Workstation Server service starts. The VMware Workstation Server service starts whenever you restart the host system.
What to do next
To use the latest features, upgrade existing virtual machines to the new version of Workstation. See Change the Hardware Compatibility of a Virtual Machine.
If you used bridged settings to map virtual networks to specific physical or virtual adapters in the previous version of Workstation, recreate the mappings. If you created teams in the previous version of Workstation, convert the teams to use them in the new version of Workstation. See Using VMware Workstation for more information.
You can upgrade Workstation version 4, 5.x, 6.x, or 7.x to the current version of Workstation on a Linux host system by running the Linux bundle installer for Workstation. On most Linux distributions, the Linux bundle installer launches a GUI wizard. On some Linux distributions, including Red Hat Enterprise Linux 5.1, the bundle installer launches a command-line wizard instead of a GUI wizard. You can run the installer with the --console option to upgrade Workstation in a terminal window.
Remote connections and virtual machine sharing are enabled by default when you upgrade Workstation. With remote connections, you can connect to remote hosts and run remote virtual machines. With virtual machine sharing, you can create virtual machines that other instances of Workstation can access remotely.
Shared virtual machines are stored in the shared virtual machines directory, where VMware Workstation Server (vmware-workstation-server) manages them. Remote users connect to VMware Workstation Server through HTTPS port 443 on the host system.
To change the shared virtual machines directory or select a different port during the upgrade process, you must specify the --custom option. You can also change the shared virtual machines directory, select a different port, and disable remote connections and virtual machine sharing after Workstation is upgraded by modifying the Shared VMs Workstation preference setting. See Using VMware Workstation for more information.
Prerequisites
Procedure
For example: su root
The command that you use depends on your Linux distribution and configuration.
Option | Description |
---|---|
If you are installing the software from a CD | The installer file is in the Linux directory. |
If you downloaded the software | The installer file is in the download directory. |
For example: sh VMware-Workstation-xxxx-xxxx.architecture.bundle [--option]
xxxx-xxxx is the version and build numbers, architecture is i386 or x86_64, and option is a command line option.
If you are using the --console option or installing Workstation on a host system that does not support the GUI wizard, press Enter to scroll through and read the license agreement or type q to skip to the [yes/no] prompt.
After Workstation is upgraded, vmware-workstation-server starts on the host system. vmware-workstation-server starts whenever you restart the host system.
What to do next
To use the latest features, upgrade existing virtual machines to the new version of Workstation. See Change the Hardware Compatibility of a Virtual Machine.
If you used bridged settings to map virtual networks to specific physical or virtual adapters in the previous version of Workstation, recreate the mappings. If you created teams in the previous version of Workstation, convert the teams to use them in the new version of Workstation. See Using VMware Workstation for more information.
You can change the hardware compatibility of a virtual machine. All virtual machines have a hardware version. The hardware version indicates which virtual hardware features that the virtual machine supports, such as BIOS or EFI, number of virtual slots, maximum number of CPUs, maximum memory configuration, and other hardware characteristics.
When you upgrade Workstation, you must change the hardware compatibility of virtual machines that were created in previous versions of Workstation so that they can use the new features in the new version of Workstation. You can run older versions of virtual machines in the new version of Workstation, but you will not have the benefits of the new features.
If you want a virtual machine to remain compatible with other VMware products that you are using, you might not want to change the hardware compatibility to the latest Workstation version.
If you decide not to change the hardware compatibility of a virtual machine, you should consider upgrading to the latest version of VMware Tools to obtain the latest VMware Tools features.
Prerequisites
Familiarize yourself with the considerations and limitations of changing the hardware compatibility of a virtual machine. See Considerations for Changing the Hardware Compatibility of a Virtual Machine.
Procedure
If you specified a static IP address for the virtual machine, that setting might be changed to automatic assignment by DHCP after the upgrade.
When you select a hardware compatibility setting, a list of the VMware products that are compatible with that setting appears. For example, if you select Workstation 4, 5, or 6, a list of Workstation 6.5 and later features that are not supported for that Workstation version also appears.
If you upgrade a virtual machine that contains a Windows 98 operating system to a Workstation 6.5 or later virtual machine, you must install a PCI-PCI bridge driver when you power on the virtual machine.
Because Workstation 6.5 and later versions have 32 more PCI-PCI bridges than Workstation 6, you might need to respond to the prompt 32 or 33 times.
You should update VMware Tools to the version included with the latest version of Workstation, even if you upgraded the virtual machine to an earlier version of Workstation. Do not remove the older version of VMware Tools before installing the new version.
If you are upgrading a virtual machine that runs from a physical disk, you can safely ignore this message: Unable to upgrade drive_name. One of the supplied parameters is invalid.
Before you change the hardware compatibility of a virtual machine, you should be aware of certain considerations and limitations.
You uninstall Workstation on a Windows host by using the Windows setup program. On a Linux host, you uninstall Workstation by running the bundle installer.
If you uninstall Workstation and do not save the configuration, then when you reinstall Workstation, shared virtual machines will no longer appear in the Shared VMs list in the virtual machine library. To display virtual machines in the list again, you will need to share them again.
You can run the Windows setup program to uninstall Workstation from a Windows host system.
Procedure
If you log in to the domain, the domain account must also be a local administrator.
If autorun is enabled, the installation program begins.
If you have a Workstation CD, the setup file is called setup.exe. If you downloaded the installation software, the setup filename is similar to VMware-workstation-xxxx-xxxx.exe, where xxxx-xxxx is the version and build numbers.
You must run a command to uninstall Workstation from a Linux host.
Prerequisites
Verify that you have root access to the host system.
Procedure
For example: su root
The command that you use depends on your Linux distribution and configuration.
How you start Workstation depends on the host system platform and the options that you selected during Workstation installation.
On Windows host systems, you might have a desktop shortcut, a quick launch shortcut, or a combination of these options in addition to a Start menu item.
On Linux host systems, you start Workstation from the command line. On some Linux distributions, including Red Hat Enterprise Linux 5.1, you can also start Workstation from the System Tools menu under Applications.
Procedure
Option | Command |
---|---|
/usr/bin is in your default path | vmware & |
/usr/bin is not in your default path | /usr/bin/vmware & |
The first time you start Workstation, Workstation prompts you to accept the End User License Agreement. After you start Workstation, the Workstation window opens.
A virtual machine is like a separate computer that runs in a window on the host system. Workstation displays more than the screen of another computer. From the Workstation window, you can interact with and run virtual machines. You can also switch easily from one virtual machine to another.
The best way to learn how to use Workstation is to use it. The Workstation window is designed to be intuitive and easy to use.
You interact with virtual machines through the Workstation window.
Procedure
The summary view shows a summary of configuration information and the virtual machine state. You can power on the virtual machine and edit virtual machine settings from the summary view.
The console view is like the monitor display of a physical computer. You can click the console view button on the toolbar to switch between the console and summary views.
You can use the VM menu when a virtual machine is powered on or off. If an operation is not supported for the virtual machine in its current state, the menu item is not available.
You can use the buttons on the toolbar to take and manage snapshots, enter full screen and Unity mode, cycle multiple monitors, and switch between the console and summary views.
You can click or right-click on a removable device icon to connect or disconnect the device or edit its settings, and you can click the Message log icon to view the message log. Messages include warning information about the virtual machine. If the icon is dimmed, all messages have already been read.
The virtual machine library appears on the left side of the Workstation window. You use the library to view and select virtual machines, folders, and remote hosts in Workstation. The library appears by default.
Prerequisites
If the library is not visible, select View > Customize > Library.
Procedure
For example, to find all of the virtual machines that have a Windows 7 guest operating system, type Windows 7. You can also search for folders and remote hosts.
By default, the library shows all items.
The thumbnail bar appears along the bottom of the Workstation window.
For active virtual machines, Workstation updates the thumbnail in real time to show the actual content of the virtual machine. When a virtual machine is suspended, the thumbnail is a screenshot of the virtual machine at the time that it was suspended.
Prerequisites
If the thumbnail bar is not visible, select View > Customize > Thumbnail Bar.
Procedure
Thumbnails appear in the same order as the virtual machine tabs. To move a virtual machine tab, drag and drop it to a new location.
The drop-down menu is a down-arrow on the thumbnail bar.
The status bar appears at the bottom of the Workstation window. You can use the icons on the status bar to see Workstation messages and perform actions on devices such as hard disks, CD/DVD drives, floppy drives, and network adapters. The status bar appears by default.
Procedure
Messages include warning information about the virtual machine. If the icon is dimmed, all messages have already been read.
Workstation creates a tab in the right pane of the Workstation window when you select an item in the library. Tabs appear by default.
Procedure
You can customize the appearance of the Workstation window by selecting items from the View menu.
Procedure
Option | Description |
---|---|
Library | The virtual machine library appears in the left side of the window. You can use the library to view and select virtual machines, folders, and remote hosts in Workstation. The library appears by default. |
Thumbnail Bar | A thumbnail bar appears at the bottom of the window. Depending on the thumbnail bar option that is selected, the thumbnail bar shows all open virtual machines or the virtual machines in the selected folder. |
Toolbar | A toolbar appears at the top of the window. You can use the icons on the toolbar to start and stop virtual machines, take snapshots, change the display, and perform other common tasks. The toolbar appears by default. |
Status Bar | A status bar appears at the bottom of the window when a virtual machine is selected. You can use the icons on the status bar to see Workstation messages and perform actions on virtual machine devices such as hard disks, CD/DVD drives, floppy drives, and network adapters. The status bar appears by default. |
Tabs | Workstation creates a tab in the right pane when you select an item in the library. Tabs appear by default. |
Option | Description |
---|---|
Open Virtual Machines | The thumbnail bar shows thumbnails for all open virtual machines. |
Folder View Virtual Machines | The thumbnail bar shows thumbnails for virtual machines in the selected folder. |
You can use keyboard shortcuts to interact with Workstation and with virtual machines. Most of the available keyboard shortcuts for Workstation are listed next to their associated commands in Workstation menus.
Default Hot-Key Combinations
Shortcut | Action |
---|---|
Ctrl+G | Grab input from the keyboard and mouse. |
Ctrl+Alt | Release the mouse cursor. |
Ctrl+Alt+Insert | Shut down or, depending on the guest operating system, log out of the guest operating system. This command is received solely by the virtual machine. |
Ctrl+Alt+Delete | Shut down or, depending on the operating system, log out of the guest operating system. On a Windows host, if you do not use the enhanced virtual keyboard feature, both the host operating system and the virtual machine receive this command, even when Workstation has control of input. Cancel the ending of the host operating system session and return to the virtual machine to log out or shut down or perform administrative tasks. |
Ctrl+Alt+Enter | Enter full screen mode. |
Ctrl+Alt+spacebar | Send any command to the virtual machine so that Workstation does not process it. Hold down Ctrl+Alt as you press and release the spacebar, and continue to hold the Ctrl+Alt keys down as you press the next key in the combination. |
Ctrl+Tab Ctrl+Shift+Tab | (Windows hosts only) Switch among tabs. |
Ctrl+Alt+right arrow | In full screen mode, switch to the next powered-on virtual machine. |
Ctrl+Alt+left arrow | In full screen mode, switch to the previous powered-on virtual machine. |
Ctrl+Shift+U | In Unity mode, give access to the virtual machine Start or Applications menu. You can change the Unity hot-key combination by modifying Unity preference settings. |
You can change the default hot-key combinations by modifying Workstation preference settings. If you change the hot-key settings, substitute your new hot-key combination for Ctrl+Alt. For example, if you change the hot-key combination for common virtual machine operations to Ctrl+Shift, you press Ctrl+Shift instead of Ctrl+Alt to release control from the current virtual machine.
See Using VMware Workstation for information on changing the default hot-key combinations.
The Workstation online help contains information about Workstation settings and common tasks. Use the online help when you need to quickly find information about Workstation preferences, virtual hardware settings, and virtual machine options.
For example, if you are configuring a virtual machine and you need information about a specific hardware setting, click Help on the dialog box that contains the setting. The Help window opens and a context-sensitive help topic appears in the right pane. To see the entire help system, select Help > Help Topics (Windows host) or Help > Contents (Linux host).
When you want to create a virtual machine in Workstation, you typically use the New Virtual Machine wizard. You can create a virtual machine in a minimum number of steps by selecting the typical configuration option in the New Virtual Machine wizard.
With Workstation, you can also clone virtual machines from existing virtual machines or virtual machine templates, import Open Virtualization Format (OVF) and third-party virtual machines, create virtual machines that remote Workstation users can use, and create virtual machines on remote hosts. See Using VMware Workstation for information on these advanced features.
A virtual machine is a software computer that, like a physical machine, runs an operating system and applications. A virtual machine uses the physical resources of the physical machine on which it runs, which is called the host system. Virtual machines have virtual devices that provide the same functionality as physical hardware, but with the additional benefits of portability, manageability, and security.
A virtual machine has an operating system and virtual resources that you manage in much the same way that you manage a physical computer. For example, you install an operating system in a virtual machine in the same way that you install an operating system on a physical computer. You must have a CD-ROM, DVD, or ISO image that contains the installation files from an operating system vendor.
When you select the typical configuration option in the New Virtual Machine wizard, Workstation creates a virtual machine that has specific hardware and software features. After the virtual machine is created, you can change many of these features by modifying virtual machine settings.
Shared virtual machines and virtual machines that you create on remote hosts do not have the same features as virtual machines that you create on the local host system. See Using VMware Workstation for information on creating shared and remote virtual machines.
Hardware Features
A typical virtual machine has the following hardware features.
The options that you select when you create the virtual machine determine the amount of memory that is allocated to the virtual machine, the size of the virtual disk, and whether the virtual disk is split into multiple virtual disk files.
Software Features
A typical virtual machine has the following software features.
When you select the typical configuration option in the New Virtual Machine wizard, you must specify or accept defaults for a few basic virtual machine settings.
After you create a typical virtual machine, you can add devices and set up custom network connections.
The New Virtual Machine prompts you to select the source media for the operating system that will run inside the virtual machine. You can specify an installer disc inserted in a physical drive, an ISO image file, or you can instruct the New Virtual Machine wizard to create a virtual machine that has a blank hard disk.
If you select an installer disc or an ISO image file and the operating system supports Easy Install, the guest operating system installation is automated and VMware Tools is installed. If the installer disc or ISO image file contains a product key number and is already set up to perform an unattended installation, the only benefit of using Easy Install is the automatic installation of VMware Tools.
For remote virtual machines, you must specify whether the physical drive or ISO image file is located on the local host or remote host before you select the installer disc or ISO image file.
If you instruct the New Virtual Machine wizard to create a virtual machine that has a blank hard disk, the wizard prompts you to specify an operating system and version and you must install the guest operating system manually after the virtual machine is created. Workstation uses this information to set the appropriate default values, name files associated with the virtual machine, adjust performance settings, and work around special behaviors and bugs in the guest operating system. If the operating system you plan to install is not listed in the wizard, select Other for both the operating system and version.
If you are installing an operating system that supports Easy Install but you do not want to use Easy Install, you can instruct the wizard to create a virtual machine that has a blank disk and install the guest operating system manually.
When the New Virtual Wizard detects an operating system that supports Easy Install, the wizard prompts you for information about the guest operating system. After the virtual machine is created, the guest operating system installation is automated and VMware Tools is installed.
For Windows guest operating systems, you must provide the following Easy Install information.
Easy Install Information for Windows Guests
Easy Install Prompt | Description |
---|---|
Windows product key | (Optional) Type a product key unless the installation media contains a volume license product key. If you provide a product key here, you are not prompted to provide a product key when you install the guest operating system. |
Version of Windows to install | For Windows Vista, Windows 7, and Windows Server 2008 guest operating systems, select the operating system edition. |
Full name | The name to use to register the guest operating system. Do not use the name Administrator or Guest. If you use one of these names, you must enter a different name when you install the guest operating system. |
Password | (Optional) The password to use for an account with Administrator permissions on Windows operating systems other than Windows 2000. On Windows 2000, this is the password for the Administrator account. On Windows XP Home, an Administrator account without a password is created and you are automatically logged in to the guest operating system. |
Log on automatically (requires a password) | (Optional) Save your login credentials and bypass the login dialog box when you power on the virtual machine. You must enter a name and password to use this feature. |
For Linux guest operating systems, you must provide the following Easy Install information.
Easy Install Information for Linux Guests
Prompt | Description |
---|---|
Full name | The name to use to register the guest operating system, if registration is required. Workstation uses the first name to create the host name for the virtual machine. |
User name | Your user name. You can use lowercase letters, numbers, and dashes, but avoid using user names that begin with a dash. Do not use the name root. Some operating systems set up sudo access for this user and other operating systems require this user to use su to obtain root privileges. |
Password | The password for the User name and the root user. |
The New Virtual Machine wizard prompts you for a virtual machine name and a directory for the virtual machine files.
The name of the default directory for virtual machine files is derived from the name of the guest operating system, for example, Microsoft Windows 7 (32-bit).
For standard virtual machines, the default directory for virtual machine files is located in the virtual machine directory. For best performance, do not place the virtual machines directory on a network drive. If other users need to access the virtual machine, consider placing the virtual machine files in a location that is accessible to those users.
See Using VMware Workstation for descriptions of the virtual machine files.
Workstation stores standard virtual machines in the virtual machines directory.
The default location of the virtual machines directory depends on the host operating system.
Default Virtual Machines Directory
Host Operating System | Default Location |
---|---|
Windows XP Windows Server 2003 | C:\Documents and Settings\username\My Documents\My Virtual Machines username is the name of the currently logged in user. |
Windows Vista Windows 7 | C:\Users\ username \Documents\Virtual Machines username is the name of the currently logged in user. |
Linux | homedir/vmware homedir is the home directory of the currently logged in user. |
If you instruct the New Virtual Machine wizard to create a new virtual disk during a custom configuration, the wizard prompts you to set the size of the virtual disk and specify whether to split the disk into multiple virtual disk (.vmdk) files.
A virtual disk is made up of one or more virtual disk files. Virtual disk files store the contents of the virtual machine hard disk drive. Almost all of the file content is virtual machine data. A small portion of the file is allotted to virtual machine overhead. If the virtual machine is connected directly to a physical disk, the virtual disk file stores information about the partitions that the virtual machine is allowed to access.
You can set a size between 0.001GB and 2TB for a virtual disk file. You can also select whether to store a virtual disk as a single file or split it into multiple files.
Select Split virtual disk into multiple files if the virtual disk is stored on a file system that has a file size limitation. When you split a virtual disk less than 950GB, a series of 2GB virtual disk files are created. When you split a virtual disk greater than 950GB, two virtual disk files are created. The maximum size of the first virtual disk file is 1.9TB and the second virtual disk file stores the rest of the data.
After you create a virtual machine, you can edit virtual disk settings and add additional virtual disks.
You can click Customize Hardware on the last page of the New Virtual Machine wizard to customize the virtual machine hardware.
You can change the default hardware settings, including memory allocation, number of virtual CPUs, CD/DVD and floppy drive settings, and the network connection type.
See Using VMware Workstation for information on customizing virtual machine hardware.
You can print this worksheet and write the values to specify when you create a typical virtual machine.
Worksheet: Typical Virtual Machine
Option | Write Your Value Here |
---|---|
Guest operating system source | |
Guest operating system type for manual installation | |
Easy Install information for Windows guests
| |
Easy Install information for Linux guests
| |
Virtual machine name | |
Virtual machine location | |
Disk capacity |
When you select the typical configuration option in the New Virtual Machine wizard, you create a virtual machine in a minimum number of steps.
You must select a custom configuration if you need to create a virtual machine that has a hardware compatibility setting that is different from the default hardware compatibility setting, select the I/O controller type for the SCSI controller, select the virtual disk type, configure a physical disk, or allocate all virtual disk space rather than let disk space gradually increase. See Using VMware Workstation for information about creating a custom configuration.
Prerequisites
Procedure
Option | Description |
---|---|
Windows host |
|
Linux host | Select File > New Virtual Machine. |
Option | Description |
---|---|
Use a physical disc | Select the physical drive where you inserted the installation disc. |
Use an ISO image | Type or browse to the location of the ISO image file. |
Install the guest operating system later | Create a virtual machine that has a blank disk. You must install the guest operating system manually after the virtual machine is created. |
Option | Description |
---|---|
If you are using Easy Install | Type the Easy Install information for the guest operating system. |
If you are not using Easy Install | Select the guest operating system and version. If the guest operating system is not listed, select Other for both the operating system and version. |
You can also modify virtual hardware settings after you create the virtual machine.
This option is not available if you are installing the guest operating system manually.
If you are using Easy Install, the guest operating system installation begins when the virtual machine powers on. The guest operating system installation is automated and typically runs without requiring any input from you. After the guest operating system is installed, Easy Install installs VMware Tools.
If you are not using Easy Install, the virtual machine appears in the library.
What to do next
If you used Easy Install and the virtual machine did not power on when the New Virtual Machine wizard finished, power on the virtual machine to start the guest operating system installation. See Use Easy Install to Install a Guest Operating System.
If you did not use Easy Install, install the guest operating system manually. See Install a Guest Operating System Manually.
When you use Easy Install, you usually do not need to provide information during guest operating system installation.
If you did not provide all of the Easy Install information in the New Virtual Machine wizard, you might be prompted for a product key, username, or password.
Also, if the guest operating system installation consists of multiple discs or ISO image files, the installer might prompt you for the next disk.
Procedure
Mouse and keyboard input are captured by the virtual machine.
Option | Description |
---|---|
Windows host | Click Change Disk and browse to the next ISO image file. |
Linux host |
|
Installing a guest operating system in a virtual machine is similar to installing an operating system on a physical computer. If you do not use Easy Install when you create a virtual machine in the New Virtual Machine wizard, you must install the guest operating system manually.
You can install a guest operating system from an installer disc or ISO image file. You can also use a PXE server to install the guest operating system over a network connection. If the host configuration does not permit the virtual machine to boot from an installer disc, you can create an ISO image file from the installer disc.
Prerequisites
Procedure
What to do next
Install VMware Tools. You should install VMware Tools before you activate the license for the operating system. See Installing VMware Tools.
Installing VMware Tools is part of the process of creating a new virtual machine. Upgrading VMware Tools is part of the process of keeping virtual machines up to current standards.
For the best performance and latest updates, install or upgrade VMware Tools to match the version of Workstation that you are using. Other compatibility options are also available.
See Installing and Configuring VMware Tools for complete information on installing, upgrading, and configuring VMware Tools.
VMware Tools is a suite of utilities that enhances the performance of the virtual machine’s guest operating system and improves management of the virtual machine.
Although the guest operating system can run without VMware Tools, many VMware features are not available until you install VMware Tools. For example, if you do not have VMware Tools installed in your virtual machine, you cannot use the shutdown or restart options from the toolbar. You can use only the power options.
You can use the Windows Easy Install or Linux Easy Install feature to install VMware Tools as soon as the operating system is finished installing.
The installers for VMware Tools are ISO image files. An ISO image file looks like a CD-ROM to your guest operating system. There is an ISO image file for each type of guest operating system, including Windows, Linux, Solaris, FreeBSD, and NetWare. When you select the command to install or upgrade VMware Tools, the virtual machine’s first virtual CD-ROM disk drive temporarily connects to the VMware Tools ISO file for your guest operating system.
The most recent versions of the ISO files are stored on a VMware Web site. When you select the command to install or upgrade VMware Tools, the VMware product determines whether it has downloaded the most recent version of the ISO file for the specific operating system. If the latest version has not been downloaded or if no VMware Tools ISO file for that operating system has ever been downloaded, you are prompted to download the file.
The installation procedure varies, depending on the operating system.
You can upgrade VMware Tools manually, or you can configure virtual machines to check for and install newer versions of VMware Tools.
The guest operating system checks the version of VMware Tools when you power on a virtual machine. The status bar of the virtual machine displays a message when a new version is available.
In Windows virtual machines, you can set VMware Tools to notify you when an upgrade is available. If this notification option is enabled, the VMware Tools icon in the Windows taskbar includes a yellow caution icon when a VMware Tools upgrade is available.
To install a VMware Tools upgrade, you can use the same procedure that you used for installing VMware Tools the first time. Upgrading VMware Tools means installing a new version.
For Windows and Linux guest operating systems, you can configure the virtual machine to automatically upgrade VMware Tools. Although the version check is performed when you power on the virtual machine, on Windows guest operating systems, the automatic upgrade occurs when you power off or restart the virtual machine. The status bar displays the message Installing VMware Tools ... when an upgrade is in progress.
When you upgrade VMware Tools on Linux guest operating systems, new network modules are available but are not used until you either reboot the guest operating system or stop networking, unload and re-load the VMware networking kernel modules, and then restart networking. This behavior means that even if VMware Tools is set to automatically upgrade, you must reboot or re-load network modules to make new features available.
This strategy avoids network interruptions and allows you to work with VMware Tools over SSH.
For best performance and the latest updates, install or upgrade VMware Tools to the VMware Tools version that is included with the VMware product you are using. Other compatibility options are also available.
You can manually install or upgrade VMware Tools on Windows, Linux, NetWare, Solaris, and FreeBSD virtual machines.
If you are installing VMware Tools in a number of Windows virtual machines, you can automate its installation by using the VMware Tools setup.exe at a command prompt in the guest operating system. See Installing and Configuring VMware Tools for more information.
All supported Windows guest operating systems support VMware Tools.
Install the latest version of VMware Tools to enhance the performance of the virtual machine's guest operating system and improve virtual machine management. When you power on a virtual machine, if a new version of VMware Tools is available, you see a notification in the status bar of the guest operating system.
For Windows 2000 and later, VMware Tools installs a virtual machine upgrade helper tool. This tool restores the network configuration if you upgrade from virtual hardware version 4 to version 7 or higher.
Prerequisites
The autodetect setting enables the virtual machine's first virtual CD/DVD drive to detect and connect to the VMware Tools ISO file for a VMware Tools installation. This ISO file looks like a physical CD to your guest operating system. Use the virtual machine settings editor to set the CD/DVD drive to autodetect a physical drive.
Procedure
If an earlier version of VMware Tools is installed, the menu item is Update VMware Tools.
If autorun is enabled for the CD-ROM drive in the guest operating system, the VMware Tools installation wizard appears.
What to do next
If a new virtual hardware version is available for the virtual machine, upgrade the virtual hardware.
For Linux virtual machines, you manually install or upgrade VMware Tools by using the command line.
Install the latest version of VMware Tools to enhance the performance of the virtual machine's guest operating system and improve virtual machine management. When you power on a virtual machine, if a new version of VMware Tools is available, you see a notification in the status bar of the guest operating system.
Prerequisites
Procedure
If an earlier version of VMware Tools is installed, the menu item is Update VMware Tools.
If the CD-ROM device is mounted, the CD-ROM device and its mount point are listed as something like this:
Some Linux distributions use different mount point names. For example, on some distributions the mount point is /media/VMware Tools rather than /mnt/cdrom. Modify the command to reflect the conventions that your distribution uses.
Some Linux distributions use different device names or organize the /dev directory differently. If your CD-ROM drive is not /dev/cdrom or if the mount point for a CD-ROM is not /mnt/cdrom, modify the command to reflect the conventions that your distribution uses.
cd /tmp
The location of this directory depends on where you placed it during the previous installation. Often this directory is placed in /tmp/vmware-tools-distrib.
The value x.x.x is the product version number, and yyyy is the build number of the product release.
If you attempt to install a tar installation over an RPM installation, or the reverse, the installer detects the previous installation and must convert the installer database format before continuing.
If your Linux distribution automatically mounted the CD-ROM, you do not need to unmount the image.
Usually, the vmware-config-tools.pl configuration file runs after the installer file finishes running.
Depending on the features you use, these instructions can include restarting the X session, restarting networking, logging in again, and starting the VMware User process. You can alternatively reboot the guest operating system to accomplish all these tasks.
What to do next
If a new virtual hardware version is available for the virtual machine, upgrade the virtual hardware.
For NetWare virtual machines, you manually install or upgrade VMware Tools by using the command line.
Install the latest version of VMware Tools to enhance the performance of the virtual machine's guest operating system and improve virtual machine management. When you power on a virtual machine, if a new version of VMware Tools is available, you see a notification in the status bar of the guest operating system.
Prerequisites
Procedure
If an earlier version of VMware Tools is installed, the menu item is Update VMware Tools.
Operating System | Command |
---|---|
NetWare 6.5 | LOAD CDDVD |
NetWare 6.0 or NetWare 5.1 | LOAD CD9660.NSS |
NetWare 4.2 (not available in vSphere) | load cdrom |
When the installation finishes, the message VMware Tools for NetWare are now running appears in the Logger Screen for NetWare 6.5 and NetWare 6.0 guest operating systems and in the Console Screen for NetWare 4.2 and 5.1 operating systems.
What to do next
If a new virtual hardware version is available for the virtual machine, upgrade the virtual hardware.
For Solaris virtual machines, you manually install or upgrade VMware Tools by using the command line.
Install the latest version of VMware Tools to enhance the performance of the virtual machine's guest operating system and improve virtual machine management. When you power on a virtual machine, if a new version of VMware Tools is available, you see a notification in the status bar of the guest operating system.
Prerequisites
Procedure
If an earlier version of VMware Tools is installed, the menu item is Update VMware Tools.
cd /tmp
Usually, the vmware-config-tools.pl configuration file runs after the installer file finishes running.
Depending on the features you use, these instructions can include restarting the X session, restarting networking, logging in again, and starting the VMware User process. You can alternatively reboot the guest operating system to accomplish all these tasks.
What to do next
If a new virtual hardware version is available for the virtual machine, upgrade the virtual hardware.
For FreeBSD virtual machines, you manually install or upgrade VMware Tools by using the command line.
Install the latest version of VMware Tools to enhance the performance of the virtual machine's guest operating system and improve virtual machine management. When you power on a virtual machine, if a new version of VMware Tools is available, you see a notification in the status bar of the guest operating system.
Prerequisites
Procedure
If an earlier version of VMware Tools is installed, the menu item is Update VMware Tools.
For example, type mount /cdrom.
cd /tmp
Usually, the vmware-config-tools.pl configuration file runs after the installer file finishes running.
Depending on the features you use, these instructions can include restarting the X session, restarting networking, logging in again, and starting the VMware User process. You can alternatively reboot the guest operating system to accomplish all these tasks.
What to do next
If a new virtual hardware version is available for the virtual machine, upgrade the virtual hardware.
One of the executables used by VMware Tools in Linux, Solaris, and FreeBSD guest operating systems is the VMware User process. This program implements the fit-guest-to-window feature and Unity mode, among other features.
Normally, this process is started automatically after you configure VMware Tools and then log out of the desktop environment and log back in. You must start the process manually in the following environments:
Procedure
The vmware-user program is located in the directory where you selected to install binary programs, which defaults to /usr/bin. The startup script that needs to be modified depends on your particular system.
Occasionally, an upgrade of VMware Tools is incomplete. You can usually solve the problem by uninstalling VMware Tools and then reinstalling.
Prerequisites
Procedure
Operating System | Action |
---|---|
Windows 7 | Use the guest operating system's Programs > Uninstall a program item. |
Windows Vista and Windows Server 2008 | Use the guest operating system's Programs and Features > Uninstall a program item. |
Windows XP and earlier | Use the guest operating system's Add/Remove Programs item. |
Linux | On a Linux guest operating system that has VMware Tools installed by using an RPM installer, enter the following command in a terminal window: rpm -e VMwareTools |
Linux, Solaris, FreeBSD, NetWare | Log in as root and enter the following command in a terminal window: vmware-uninstall-tools.pl |
Mac OS X Server | Use the Uninstall VMware Tools application, found in /Library/Application Support/VMware Tools. |
What to do next
Reinstall VMware Tools.
Installing new software in a virtual machine is similar to installing new software on a physical computer. Only a few additional steps are required.
Prerequisites
Procedure
Some applications use a product activation feature that creates a key based on the virtual hardware in the virtual machine where it is installed. Changes in the configuration of the virtual machine might require you to reactivate the software. Setting the memory size minimizes the number of significant changes.
When you use a virtual machine in Workstation, you can transfer files and text between the host system and the virtual machine, print to host printers, connect removable devices, and change display settings.
You can also use folders to organize and manage virtual machines, and take snapshots to preserve virtual machine states.
With more advanced Workstation features, you can map virtual disks, set up shared folders to share files between virtual machines and between virtual machines and the host system, share virtual machines with remote users, and use virtual machines on remote hosts. See Using VMware Workstation for complete information on these and other advanced features.
You can start a virtual machine from the VM menu or from the toolbar. When you use the VM menu, you can select a soft or hard power option or start the virtual machine in BIOS setup mode.
When virtual machines are in a folder, you can perform batch power operations. See Using Folders to Manage Virtual Machines.
When you use Workstation to connect to a remote server, you can start virtual machines on a remote host. See Using VMware Workstation for information on using remote virtual machines.
Prerequisites
If the virtual machine does not appear in the library, select File > Open and browse to the virtual machine configuration (.vmx) file.
Procedure
Option | Description |
---|---|
Power On | (Hard option) Workstation starts the virtual machine. |
Start Up Guest | (Soft option) Workstation starts the virtual machine and VMware Tools runs a script in the guest operating system. On Windows guests, if the virtual machine is configured to use DHCP, the script renews the IP address of the virtual machine. On a Linux, FreeBSD, or Solaris guest, the script starts networking for the virtual machine. |
Power On to BIOS | Workstation starts the virtual machine in BIOS setup mode. |
The start power control setting that is configured for the virtual machine determines whether Workstation performs a hard or soft power on operation. The configured behavior appears in a tooltip when you mouse over the button.
What to do next
Click anywhere inside the virtual machine console to give the virtual machine control of the mouse and keyboard.
You can shut down a virtual machine from the VM menu or from the toolbar. When you use the VM menu, you can select a hard or soft power option.
You are not required to power off a virtual machine that is running on the local host system before you exit Workstation. You can exit Workstation and leave the virtual machine running in the background. See Closing Virtual Machines and Exiting Workstation.
When virtual machines are in a folder, you can perform batch power operations. See Using Folders to Manage Virtual Machines.
Procedure
Option | Description |
---|---|
Power Off | (Hard option) Workstation powers off the virtual machine abruptly with no consideration for work in progress. |
Shut Down Guest | (Soft option) Workstation sends a shut down signal to the guest operating system. An operating system that recognizes the signal shuts down gracefully. Not all guest operating systems respond to a shutdown signal from Workstation. If the guest operating system does not respond to the signal, shut down from the guest operating system as you would a physical machine. |
The stop power control setting that is configured for the virtual machine determines whether Workstation performs a hard or soft power off operation. The configured behavior appears in a tooltip when you mouse over the button.
You can pause a virtual machine multiple times for a few seconds, or up to several minutes. The pause feature is useful when a virtual machine is engaged in an lengthy, processor-intensive activity that prevents you from using the host system to do a more immediate task.
You cannot pause a remote virtual machine.
Prerequisites
Familiarize yourself with the restrictions and limitations of the pause feature. See Pause Feature Restrictions and Limitations.
Procedure
The virtual machine display dims and a play button appears over the display. Paused virtual machines that are configured to display on more than one monitor have a play button on each monitor.
The pause feature has certain restrictions and limitations.
You suspend a virtual machine when you want to save its current state. When you resume the virtual machine, applications that were running before the virtual machine was suspended resume in their running state and their content is unchanged.
How quickly the suspend and resume operations perform depends on the how much data changed after you started the virtual machine. The first suspend operation typically takes longer than subsequent suspend operations. When you suspend a virtual machine, Workstation creates a virtual machine suspended state (.vmss) file in the working directory.
After you resume a virtual machine and do more work, you cannot return to the state that the virtual machine was in when you suspended it. To return to the same state repeatedly, you must take a snapshot.
When virtual machines are in a folder, you can perform batch power operations. See Using Folders to Manage Virtual Machines.
Procedure
Option | Description |
---|---|
Suspend | (Hard option) Workstation suspends the virtual machine and leaves it connected to the network. |
Suspend Guest | (Soft option) Workstation suspends the virtual machine and disconnects it from the network. VMware Tools runs a script in the guest operating system. On Windows guests, if the virtual machine is configured to use DHCP, the script releases the IP address of the virtual machine. On Linux, FreeBSD, and Solaris guests, the script stops networking for the virtual machine. |
The suspend power control setting that is configured for the virtual machine determines whether Workstation performs a hard or soft suspend operation. The configured behavior appears in a tooltip when you mouse over the button.
Option | Description |
---|---|
Resume | (Hard option) Workstation resumes the virtual machine from the suspended state. |
Resume Guest | (Soft option) Workstation resumes the virtual machine from the suspended state and reconnects it to the network. |
The suspend power control setting that is configured for the virtual machine determines whether Workstation performs a hard or soft resume operation. The configured behavior appears in a tooltip when you mouse over the button.
You can use the drag-and-drop feature to move files and directories, email attachments, plain text, formatted text, and images between the host system and virtual machines. Dragging email attachments is especially useful in Unity mode.
You can drag files or directories between the following locations.
When you drag a file or folder between the host and a virtual machine, Workstation copies the file or folder to the location where you drop it. For example, if you drop a file on the desktop icon of a word processor, the word processor opens a copy of the original file. The original file does not include changes that you make to the copy.
Initially, the application opens a copy of the file that is stored in the temp directory. On Windows, the temp directory is specified in the %TEMP% environment variable. On Linux and Solaris, the temp directory is /tmp/VMwareDnD. Save the file in a different directory to protect changes that you make.
The drag-and-drop feature has certain requirements and restrictions.
You can cut, copy, and paste text between virtual machines and between applications running in virtual machines.
You can also cut, copy, and paste images, plain text, formatted text, and email attachments between applications running on the host system and applications running in virtual machines.
Copying and pasting email attachments is especially useful in Unity mode. Use the normal hot keys or menu choices to cut or copy and paste.
The copy and paste feature has certain requirements and restrictions.
You can print from a virtual machine to any printer available to the host computer without having to install additional drivers in the virtual machine.
The Workstation printer feature uses ThinPrint technology to replicate the host system printer mapping in the virtual machine. When you enable the virtual machine printer, Workstation configures a virtual serial port to communicate with the host printers.
You cannot add a printer to a shared or remote virtual machine.
Procedure
The default device setting is to connect the virtual machine printer when the virtual machine is powered on.
What to do next
In a Print window, when you attempt to select a printer in Windows 7 virtual machines, you might see only the default printer, even though other printers are available. To see the other printers, right-click the default printer and point to Printer properties.
You can connect and disconnect removable devices in a virtual machine. You can also change the settings for a removable device by modifying virtual machine settings.
Prerequisites
Procedure
If the device is connected to the host system through a USB hub, the virtual machine sees only the USB device, not the hub.
A check mark appears next to the name of the device when the device is connected to the virtual machine and a device icon appears on the virtual machine taskbar.
You can also disconnect the device by clicking or right-clicking the device icon on the virtual machine taskbar. Using the taskbar icon is especially useful if you run the virtual machine in full screen mode.
When a virtual machine is running, its window is the active window. If you plug a USB device into the host system, the device connects to the virtual machine instead of the host by default. If a USB device connected to the host system does not connect to a virtual machine at power on, you must manually connect the device to the virtual machine.
When you connect a USB device to a virtual machine, Workstation retains the connection to the affected port on the host system. You can suspend or power off the virtual machine, or unplug the device. When you plug in the device again or resume the virtual machine, Workstation reconnects the device. Workstation retains the connection by writing an autoconnect entry to the virtual machine configuration (.vmx) file.
If Workstation cannot reconnect to the device, for example, because you disconnected the device, the device is removed and Workstation displays a message to indicate that it cannot connect to the device. You can connect to the device manually if it is still available.
Follow the device manufacturer's procedures for unplugging the device from the host computer when you physically unplug the device, move the device from host system to a virtual machine, move the device between virtual machines, or move the device from a virtual machine to the host computer. Following these procedures is especially important for data storage devices, such as zip drives. If you move a data storage device too soon after saving a file and the operating system did not actually write the data to the disk, you can lose data.
On Linux hosts, Workstation uses the USB device file system to connect to USB devices. If the USB device file system is not located in /proc/bus/usb, you must mount the USB file system to that location.
Do not attempt to add a USB drive device node directory, for example, /dev/sda, to the virtual machine as a hard disk.
Prerequisites
Verify that you have root access to the host system.
Procedure
mount -t usbfs none /proc/bus/usb
You can change the way Workstation displays virtual machines and virtual machine applications. You can use full screen mode to make the virtual machine display fill the screen and use multiple monitors, and you can use Unity mode to display applications directly on the host system desktop.
In full screen mode, the virtual machine display fills the screen and you cannot see the borders of the Workstation window.
You can configure the guest operating system to report battery information. This feature is useful when you run a virtual machine in full screen mode on a laptop. See Report Battery Information in the Guest.
Prerequisites
Procedure
The toolbar is unpinned and slides up to the top of the monitor and disappears.
If you run a virtual machine on a laptop in full screen mode, configure the option to report battery information in the guest so that you can determine when the battery is running low.
Prerequisites
Power off the virtual machine.
Procedure
Like full screen mode, exclusive mode causes the Workstation virtual machine display to fill the screen. You might want to use exclusive mode to run graphics-intensive applications, such as games, in full screen mode.
Exclusive mode has certain advantages and limitations.
Prerequisites
Procedure
On a Windows host, pressing Ctrl+Alt also exits full screen mode. On a Linux host, pressing Ctrl+Alt returns to full screen mode.
You can switch virtual machines that have Linux or Windows 2000 or later guest operating systems to Unity mode to display applications directly on the host system desktop.
In Unity mode, virtual machine applications appear on the host system desktop, you can use the virtual machine Start or Applications menu from the host system, and the virtual machine console view is hidden. Items for open virtual machine applications appear on the host system taskbar in the same way as open host applications.
On host system and virtual machine applications that are displayed in Unity mode, you can use keyboard shortcuts to copy, cut, and paste images, plain text, formatted text, and email attachments between applications. You can also drag and drop and copy and paste files between the host system and the guest operating system.
If you save a file or attempt to open a file from an application in Unity mode, the file system you see is the file system inside the virtual machine. You cannot open a file from the host operating system or save a file to the host operating system.
For some guest operating systems, application windows in Unity mode can appear only on the monitor that is set as the primary display when you have multiple monitors. If the host and guest operating systems are Windows XP or later, the application windows can appear on additional monitors.
Unity mode is not available in full screen mode on Windows.
You cannot use Unity mode with a remote virtual machine.
Prerequisites
Procedure
The console view in the Workstation window is hidden, and open applications appear in application windows on the host system desktop. A check mark appears next to Unity in the View menu.
If the host system has multiple monitors, you can configure a virtual machine to use multiple monitors. You can use the multiple-monitor feature when the virtual machine is in full screen mode.
You do not need to use the Windows display properties settings in a Windows guest operating system to configure multiple monitors.
Prerequisites
Procedure
This setting causes the virtual machine display settings to match the application window when the application window is resized.
Displaying the virtual machine on two monitors might not work correctly if this setting is enabled.
On a Windows host, you can mouse over a button on the toolbar to see its name.
The guest operating system desktop extends to the additional monitor or monitors.
The order in which the virtual machine uses the monitors depends on the order in which the monitors were added to the host operating system. If you continue to click the button, you return to fewer monitors.
If the host system has multiple monitors, you can run a different virtual machine on each monitor.
Prerequisites
Verify that the latest version of VMware Tools is installed in the guest operating system.
Procedure
Option | Description |
---|---|
Open a new Workstation window from Workstation | Select File > New Window. On Linux hosts, the windows operate in a single Workstation process. |
(Linux hosts only) Run a separate Workstation process in a different X server | Use the vmware command with the -W flag, for example, vmware -W &. |
If a virtual machine is running in one Workstation window and you want to run that virtual machine in another Workstation window, you must close the virtual machine in the first window before you attempt to open it in the other window.
You can use folders to organize and manage multiple virtual machines in the library. When virtual machines are in a folder, you can manage them on the folder tab and perform batch power operations.
When you add a virtual machine to a folder, it remains an independent entity, but you can also perform batch power operations. For example you can power on, suspend, and resume each virtual machine in a folder separately, or you can power on, suspend, and resume all of the virtual machines in a folder at the same time.
Procedure
Option | Description |
---|---|
Create a folder at the top level of the library | Right-click My Computer, select New Folder, and type a name for the folder. The folder appears under My Computer in the library. |
Create a subfolder | Right-click the folder, select New Folder, and type a name for the folder. The new folder appears under the folder in the library. |
You can create an unlimited number of folders or subfolders.
The virtual machine appears under the folder in the library. You can add an unlimited number of virtual machines to a folder.
You can remove a virtual machine from a folder or move it to a different folder or subfolder.
Procedure
The virtual machine appears under My Computer in the library.
The virtual machine appears under the folder or subfolder in the library.
When virtual machines are in a folder, you can manage them as a unit. For example, you can select multiple virtual machines on the folder tab and perform power operations on several virtual machines at the same time.
When you power on several virtual machines at the same time, Workstation delays 10 seconds before powering on the next virtual machine by default. Workstation performs power operations on virtual machines in the order in which they appear on the folder tab.
You can change the default power on delay setting by modifying a Workstation preference. See Change the Power On Delay.
Procedure
All of the virtual machines that you select must be in the same power state.
All of the virtual machines in the folder must be in the same power state.
When a virtual machine is powered on, Workstation updates the thumbnail in real time to show the actual content of the virtual machine. When a virtual machine is suspended, the thumbnail shows a screenshot of the virtual machine at the time that it was suspended.
By default, when you power on several virtual machines in a folder, Workstation delays 10 seconds before powering on the next virtual machine. The power on delay avoids overloading the CPU on the host system when you power on multiple virtual machines. You can change the default power on delay setting by modifying a Workstation preference.
Procedure
If you created a team in an earlier version of Workstation, you must convert the team before you can use the virtual machines in the current version of Workstation.
Procedure
A dialog box appears that prompts you to convert the team.
After the team is converted, the .vmtm file is deleted and the virtual machines are added to a new folder in the library.
After you convert a team, the virtual machines keep their packet loss and bandwidth settings. LAN segment information appears in the network adapter settings for each virtual machine, where you can modify it.
Taking a snapshot of a virtual machine saves its current state and enables you to return to the same state repeatedly. When you take a snapshot, Workstation captures the entire state of the virtual machine. You can use the snapshot manager to review and act on the snapshots for an active virtual machine.
A snapshot includes the contents of the virtual machine memory, virtual machine settings, and the state of all the virtual disks. When you revert to a snapshot, you return the memory, settings, and virtual disks of the virtual machine to the state they were in when you took the snapshot.
You might want to take snapshots in a linear process if you plan to make changes in a virtual machine. For example, you can take a snapshot, continue to use the virtual machine from that point, take another snapshot at a later point, and so on. You can revert to the snapshot of a previous known working state of the project if the changes do not work as expected.
For local virtual machines, you can take more than 100 snapshots for each linear process. For shared and remote virtual machines, you can take a maximum of 31 snapshots for each linear process.
If you are testing software, you might want to save multiple snapshots as branches from a single baseline in a process tree. For example, you can take a snapshot before installing different versions of an application to make sure that each installation begins from an identical baseline.
Multiple snapshots have a parent-child relationship. The parent snapshot of a virtual machine is the snapshot on which the current state is based. After you take a snapshot, that stored state is the parent snapshot of the virtual machine. If you revert to an earlier snapshot, the earlier snapshot becomes the parent snapshot of the virtual machine.
In a linear process, each snapshot has one parent and one child, except for the last snapshot, which has no children. In a process tree, each snapshot has one parent, one snapshot can have more than one child, and many snapshots have no children.
You can review all snapshots for a virtual machine and act on them directly in the snapshot manager.
You must use the snapshot manager to perform the following tasks.
All other snapshot actions are available as menu items in the Snapshot menu under the VM menu.
When you open the snapshot manager for a virtual machine, the snapshot tree appears. The snapshot tree shows all of the snapshots for the virtual machine and the relationships between the snapshots.
The You Are Here icon in the snapshot tree shows the current state of the virtual machine. The other icons that appear in the snapshot tree represent AutoProtect snapshots, snapshots of powered-on virtual machines, snapshots of powered-off virtual machines, and snapshots that are used to create linked clones.
The snapshot manager is available as a menu item in the Snapshot menu under the VM menu.
When you take a snapshot, you preserve the state of a virtual machine at a specific moment in time and the virtual machine continues to run. Taking a snapshot enables you to return to the same state repeatedly. You can take a snapshot while a virtual machine is powered on, powered off, or suspended.
Avoid taking snapshots when applications in the virtual machine are communicating with other computers, especially in production environments. For example, if you take a snapshot while the virtual machine is downloading a file from a server on the network, the virtual machine continues downloading the file after you take the snapshot. If you revert to the snapshot, communications between the virtual machine and the server are confused and the file transfer fails.
Workstation 4 virtual machines do not support multiple snapshots. You must upgrade the virtual machine to Workstation 7.x or later to take multiple snapshots.
Prerequisites
Procedure
The description is useful for recording notes about the virtual machine state captured in the snapshot.
You can restore a virtual machine to a previous state by reverting to a snapshot.
If you take a snapshot of a virtual machine and add any kind of disk, reverting to the snapshot removes the disk from the virtual machine. If associated disk (.vmdk) files are not used by another snapshot, the disk files are deleted.
If you add an independent disk to a virtual machine and take a snapshot, reverting to the snapshot does not affect the state of the independent disk.
Procedure
You can configure a virtual machine to revert to a snapshot or take a new snapshot when you power off the virtual machine. This feature is useful if you need to discard changes when a virtual machine is powered off.
Procedure
Option | Description |
---|---|
Just power off | Powers off the virtual machine without making any changes to snapshots. |
Revert to snapshot | Reverts to the parent snapshot of the current state of the virtual machine. |
Take a new snapshot | Takes a snapshot of the virtual machine state after it is powered off. The snapshot appears in the Snapshot Manager. The name of the snapshot is the date and time that the virtual machine was powered off and the description is Automatic snapshot created when powering off. Note You cannot configure this option for a shared or remote virtual machine. |
Ask me | Prompts you to power off, revert, or take a snapshot when the virtual machine is powered off. |
The AutoProtect feature preserves the state of a virtual machine by taking snapshots at regular intervals that you specify. This process is in addition to manual snapshots, which you can take at any time.
When AutoProtect snapshots are enabled for a virtual machine, Workstation shows an estimate of the minimum amount of disk space taken by AutoProtect snapshots on the Virtual Machine Settings window. This minimum is affected by the memory settings for the virtual machine. The more virtual machine memory a virtual machine has, the more disk space is available for AutoProtect snapshots.
The AutoProtect feature has certain restrictions.
Procedure
Option | Description |
---|---|
Half-Hourly | Snapshots are taken every half hour. |
Hourly | Snapshots are taken every hour. |
Daily | Snapshots are taken daily. |
The interval is measured only when the virtual machine is powered on. For example, if you set AutoProtect to take snapshots hourly and then power off the virtual machine five minutes later, the next AutoProtect snapshot takes place 55 minutes after you power on the virtual machine again, regardless of the length of time the virtual machine was powered off.
Workstation saves only one snapshot per tier, even if a snapshot matches more than one tier.
After the maximum number of AutoProtect snapshots is reached, Workstation deletes the oldest AutoProtect snapshot each time a new AutoProtect snapshot is taken. This setting does not affect the number of manual snapshots that you can take and keep.
When you delete a snapshot, you delete the state of the virtual machine that you preserved and you can never return to that state again. Deleting a snapshot does not affect the current state of the virtual machine.
If a snapshot is used to create a clone, the snapshot becomes locked. If you delete a locked snapshot, the clones created from the snapshot no longer operate.
You cannot delete a snapshot if the associated virtual machine is designated as a template for cloning.
Procedure
Option | Action |
---|---|
Delete a single snapshot | Click Delete. |
Delete the snapshot and all of its children | Right-click and select Delete Snapshot and Children. |
Delete all snapshots | Right-click, select Select All, and click Delete. |
You can close a virtual machine that is running on the local host system without powering it off. By default, Workstation prompts you to select an action when you close a powered-on virtual machine and when you exit Workstation while virtual machines are running on the local host system.
When you close a remote virtual machine, the virtual machine tab closes. If the virtual machine is powered on, it continues to run on the remote host.
Close and Exit Actions
Action | Description |
---|---|
Run in Background | Continue to run the virtual machine in the background. You can interact with the virtual machine through VNC or some other service. By default, a virtual machine status icon appears in the notification area of the taskbar on the host system. When you mouse over this icon, a tooltip shows the number of virtual machines running in the background that belong to the currently logged in user. |
Suspend | Suspend the virtual machine and save its current state. |
Power Off | Power off the virtual machine. By default, Workstation powers off the virtual machine abruptly. The effect is the same as using the power button on a physical machine. |
You can configure Workstation preference settings so that virtual machines always run in the background and you are not prompted to select an action. You can also configure virtual machine option settings to control power off behavior.
You can configure Workstation preference settings so that virtual machines always run in the background and you are not prompted to select an action when you close powered-on virtual machines.
Procedure
You can start a virtual machine that is running in the background when Workstation is not started.
Prerequisites
Set the virtual machine to run in the background. See Closing Virtual Machines and Exiting Workstation.
Procedure
A list of the virtual machines that are running in the background appears in a tooltip. The list contains the virtual machines that belong to the currently logged in user.
Workstation starts and displays the console view of the virtual machine.